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Geology and Landslide Survey Using Electrical Resistivity Imaging Method at 

Fraser Hill, Pahang 

Muhammad Afnan Iman bin Kamilan, Dr Noorzamzarina binti Sulaiman 

ABSTRACT 

Fraser Hill is a study area which located in Raub, Pahang. In this study, it will be 

focusing on geological mapping and also electrical resistivity survey for landslide. It is 

located in the longitude between 101⁰45‟30‟‟ to 101⁰47‟30‟‟ N and latitude between 

3⁰44‟30‟‟ to 3⁰42‟30‟‟ E. Sungai Teruas are set at the research area. Mapping using 

aerial image and interpretation from previous research conducted to produce the 

geological map of area Fraser Hill, Pahang with a specific dimension area of study 

which are 25km² and also doing the survey of landslide. The method uses in geological 

mapping including from the literature review, aerial photographs, and producing varies 

map for the study area using GIS. There are two rock units that was identify in research 

area which consists of granite unit and schist unit. . Landslide has the biggest influenced 

by the strength of the soil and also distribution of the rock. There are others factors that 

influence the stability of the landslide such as weathering and also water content. Some 

of these factor can be detected by using the electrical resistivity survey which also 

known as ERI. The three landslides have been choosing and for each landslide has been 

conducted one line to do the resistivity survey. The survey has been conducted in 

Wenner-Schlumberger array. The result shows the sliding surface of landslide and also 

low resistivity value. These phenomena in landslide will indicate presence of high water 

content in the material which is the weak zone of the landslide. 

Keywords – geological mapping, Fraser Hill, landslide, ArcGis, Wenner-Schlumberger 

array, resistivity method 
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Geologi dan Survei Tanah Runtuh Menggunakan Teknik Elektrik Resistiviti di 

Fraser Hill, Pahang 

ABSTRAK 

Kawasan kajian terletak di Bukit Fraser, Raub, Pahang. Dalam kajian ini, akan 

difokuskan pada pemetaan geologi dan juga kajian keberintangan elektrik bagi tanah 

runtuh. Kawasan kajian terletak di garis bujur antara 101⁰45'30'' hingga 101⁰47'30 ' U' 

dan garis lintang antara 3⁰44'30'' hingga 3⁰42'30'' T. Sungai Teruas terletak di kawasan 

kajian. Pemetaan menggunakan gambar udara dan penafsiran dari penyelidikan 

sebelumnya yang dilakukan untuk menghasilkan peta geologi kawasan Bukit Fraser, 

Pahang dengan dimensi kawasan kajian yang berkeluasan 25km² dan juga melakukan 

tinjauan tanah runtuh. Kaedah yang digunakan dalam pemetaan geologi termasuklah dari 

membuat kajian literatur, foto udara, dan menghasilkan peta yang bervariasi di kawasan 

kajian dengan menggunakan GIS. Terdapat dua unit batuan yang dapat dikenal pasti di 

kawasan penyelidikan yang terdiri daripada unit granit dan unit syis. Tanah runtuh 

paling utama dipengaruhi oleh kekuatan tanah dan juga penyebaran batu. Terdapat 

faktor lain yang mempengaruhi kestabilan tanah runtuh seperti luluhawa dan juga 

kandungan air. Semua faktor ini dapat dikesan dengan menggunakan kajian 

keberintangan elektrik yang juga dikenali sebagai ERI. Tiga tanah runtuh telah dipilih 

dan telah dilakukan satu garisan survey keberintangan bagi setiap tanah runtuh. Kajian 

telah dilakukan dengan susunan Wenner-Schlumberger. Hasilnya menunjukkan 

permukaan gelongsor tanah runtuh dan juga nilai resistiviti yang rendah. Fenomena 

kejadian tanah runtuh ini akan menunjukkan adanya kandungan air yang tinggi dalam 

bahan yang merupakan zon tanah runtuh yang lemah. 
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CHAPTER 1 

 

INTRODUCTION 

 

 

1.1  RESEARCH BACKGROUND 

 Study of geophysics is a study that focused on the physical process that occur on 

a large and small and others type of scales, it is include from the microscopic scales of 

properties to the forces like gravity and magnetism that acts towards the planetary and 

inter-planetary type of scales. Geophysics study is essential because it has an important 

impact in the welfare to society and the planet of Earth. By using the right equipment the 

earth physical properties can be measured in certain study. Generally, geophysics is the 

study to measure the physical properties under the earth‟s surface. This research is 

earlier part of final year undergraduate research project which is to investigate about 

landslide hazard that occur at Bukit Fraser. 

 Movement of rock or soil residue that move down a slope is called landslide. 

There are two common things that occur during landslide which they are result of soil 

failure and rock materials that make up the hill slope and they are driven by gravity 

forces. In a rock fall, it can require variation of size from a single boulder or topple tons 
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of millions of cubic meters of material in a debris flow. According to Geoscience 

Australia website landslides can occur due to two factors which are natural and human 

causes. 

 In this research electrical resistivity method is use to study the subsurface and 

weathering grade that affect the landslide hazard. This geophysical method can review 

the structure and conditions under the surface. Other than that, we also can classify the 

grade of weathering which is a factor of landslide to occur. 

 This project also will consist a geological mapping in Fraser Hill area. This 

geological mapping is conduct to update the geological map and study the general 

geology of study area. This part will be conduct by interpreting the map such as land use 

map, stream map, terrain map and others. It will help the study of landslide at that area. 

1.2  STUDY AREA 

a)  Location 

 Fraser Hill is generally located in Raub District,Pahang and under the 

administration of the Fraser Hill Development Corporation. According to (Chong, 

2004)Fraser Hill name are given due to Scottish traveler Louis James Fraser who bring 

the tin trade and the impact of mining of tin is ore mine is changed to Golf course in the 

heart of Fraser Hill. 

 Fraser Hill is located at central belt of Peninsular Malaysia. It lies on Titiwangsa 

Range which is act as backbone of Peninsular Malaysia. The geological mapping will be 

conducted at area South-West of Fraser Hill. The study area will covered 25km² of total 

area coverage. 
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 In this research there will be two point of landslides that has occurred at road up 

to the Fraser Hill to be taken as a study area for seismic refraction method. Landslides 

locality that needs to choose the major or obvious landslides. Other than that, landslides 

that give the biggest impact to the community, economical, infrastructures are chosen as 

study area. Figure 1.1 shows the Base Map of Study Area in Fraser Hill, Pahang. 

 

Figure 1.1 Base Map of Study Area in Fraser Hill, Pahang 
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b)  Accessibility 

 There are two way to access to Fraser Hill which from Kuala Kubu Bharu, 

Selangor and Raub, Pahang. According to the location of my study area which located at 

South-West Fraser Hill, the shortest way to access the study area is from Raub, Pahang. 

The accesses to the study area are easier and comfortable in the main road, however the 

road are at hilly and unpaved street. The street only has 2 ways for vehicle to go through. 

The Figure 1.1 shows the accessibility map of my study area. 

c) Demography 

 People distribution in Pahang have a variation ethnic which mostly is Malay by 

70%, followed by Chinese 15%, Indian 4%, and others races 4.8%. At Raub itself there 

are about 178700 people that live in that area. There are approximately 93000 male and 

85700 female in that district. The economic activity such as tourism and plantation of oil 

palm makes other races interested to living in the study area. The people distribution can 

be seen in Table 1.1 

Table 1.1 People Distribution in Pahang, Malaysia 

   (Source: https://www.citypopulation.de/en/malaysia/admin/06__pahang/) 

 

Ethnic Total population (%) 

Malay 70 

Chinese 15 

Indian 4 

Others 4.8 
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d) Land use 

 The definition of land use is referred as the human activity to the land. The 

landscape of the study area is influenced by the oil palm plantation. Oil palm plantation 

is located at North-East of my study area. This plantation is becoming the main 

economic activity at that area. The state government is responsible for the development 

of economy in Raub, Pahang. All the land use in Fraser Hill or Raub will be monitor by 

the state government. 

 Other than that, in the study area there is also reserve forest. This reserved forest 

is name as Hutan Simpan Bukit Fraser. The reserve forest is located at top of Fraser Hill 

and located between Selangor, Perak, and Pahang border. The forest is rich in flora and 

fauna, there are special flora and fauna at this place which is pine tree. It is influenced by 

the weather and temperature at this places which located at high altitude. 

e) Social Economic 

 The social economic of Bukit Fraser are dominated by full or part time 

employment, unemployment and labor force. At Fraser Hill area most of the economic 

social is based on the tourism activity. Other than that, development of economy in oil 

palm plantation also lead society survive with plantation. Most of the local people 

owning the tourism activity and plantation that make them gain money by their own. 

Besides that, at Bukit Fraser has center of education which is school, from that we can 

say that there is also have people that works as a teacher in the study area. 
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1.3 PROBLEM STATEMENT 

 On the road up and down of Fraser Hill there are lots of landslide hazard that can 

be seen along the road. It is result from the slope cutting in order of urbanization and 

infrastructures such as road. From this urbanization and infrastructures construction 

there are lots of landslide occurred at the main road of Fraser Hill. 

 The landslide hazard can cause many loses such as economic including damages 

on property, water resources, and casualties and injuries. Geological mapping is needed 

because the geological features of the area are change overtime. In terms of geological 

mapping we can identify the correlation between the Fraser Hill geological settings with 

landslide hazard. 

1.4  OBJECTIVES 

1. To generate the geological map of South-West of Fraser Hill by using map 

interpretation. 

2. To identify the rock material at subsurface that gave impact to the landslide 

geohazard. 

3. To interpret sliding plane of a landslide at slope using 2-D map of subsurface. 
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1.5  SCOPE OF STUDY 

 The study was concentrated on the causes of landslide hazard that occur at Fraser 

Hill. It is important to know the causes before other step of prevent it to be taken. 

 In order to study the causes of the landslide at Fraser Hill electrical resistivity 

method is used in this study. Electrical resistivity is used to determine the subsurface of 

the soil or rock and the weathering grade of the slope. 

 The study will be conducted at three points of landslides at road down of Fraser 

Hill to Raub. The most obvious and large landslides point will be taken as a subject of 

study. 

1.6  SIGNIFICANCE OF STUDY 

 This research would be an important one to examine the rock weathering quality 

causes of the landslide. This study will also give important information to the authorities 

of Fraser Hill to take action and steps to prevent more landslides occurs. 

 To the community of Fraser Hill they can aware about the geo-hazard activities 

at their area. It also can prevent more damage happen to infrastructure at Fraser Hill. 

 The research study will also give enlightenment to the student how to conduct 

the resistivity survey in order to investigate the landslide hazard. 
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CHAPTER 2 

 

LITERATURE REVIEW 

 

 

2.1  INTRODUCTION 

 In this part of research will be briefly explain about the background of research 

on geology, landslides impact due to weathering grades at Fraser Hill, Pahang. The 

previous research and some general information from others research will be used as a 

review to the  present works. This is important in order to complete the research 

because from previous works it is easier to find any problem or research gap that can be 

used on the present works. 

2.2  TECTONIC SETTING AND EVOLUTION OF MALAYSIA 

 Generally, Peninsular Malaysia is divided into three different longitudinal belts 

which is Western, Central, and Eastern belt (Hutchison, 1977). Every belt has its own 

distinctive characteristics and geological evolution. As for the western belt it can be 

subdivided into two  more parts which is northwest sector and a Kinta-Malacca sector. 

The northwest parts cover on  Langkawi and Kedah mainland, according to (Koopmans, 

1965) area of Langkawi is revised from Devonian to mid-Permian. Then, in the Kinta-
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Malacca sector, there was deposition of argillaceous and calcareous sediments in the 

early Paleozoic followed by more limestone deposition. There is also evidence in this 

sector that shows metamorphism and folding in the  Kuala Lumpur area which is 

possibly Devonian in age. 

 The Central Belt predominantly underlie by Permian-Triassic clastics, volcanics 

and limestone. On the Main Range Granite there are pre-early Devonian deposition of 

course clastics, argillaceous sediments chert and other rock occur in the marginal belt 

forms the foothill. On the foothills belt there are ultramafic bodies that were emplaced 

and during Devonian the whole belt regionally probably undergo metamorphism 

process. On the northern part of the  central belt there are also occupied with Taku 

Schist and it expose mainly schists, amphiboles and phyllites. The regional metamorphic 

rocks adjacent to the Taku Schists include the Triassic. Then, the rock assemblage inside 

the Taku Schists has some similarity to those of the Permian-Triassic outside and it is 

possible that they represent pre-Permian rocks. The Taku Schist and their adjacent areas 

during late Triassic suffered uplift, recumbent style folding and regional metamorphism. 

In the rest of the Central Belt, the orogenic uplift also terminated the marine 

sedimentation. The continental deposition begins and continued up to the early 

Cretaceous. During the Late Cretaceous, the continental deposits were uplifted and 

gently folded. 

 While, at the Eastern Belt is large underlay by Carboniferous and Permian 

clastics and volcanics. During late Paleozoic there are probably occur a phase of 

regional metamorphism, folding and uplift which followed by deposition of an older 

series of continental deposits such as the Murau and Redang conglomerates according to 
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(Khoo & Tan, 1983). In the Late Triassic orogenic event uplifted the Eastern Belt. After 

that, deposition of a younger series of continental deposits which are only gently dipping 

and probably they were uplifted in the late Cretaceous. 

2.3  GEOLOGICAL SETTING OF FRASER HILL, PAHANG 

 Fraser Hill located at uplift of granite batholith of Main Range of Titiwangsa 

which is dominated with biotite granite and amphibole granite. This main range was 

integrated with two major fault which is Kuala Lumpur Fault and Bukit Tinggi Fault. 

Other than that, minor fault  also can be seen at this range that the granite outcrop has 

been foliated and has long lineation and mylonite (Koopmans, 1974) 

 The earlier geology research has been conduct at Fraser Hill is the study that has 

been doing by (Roe, 1951)In that study it stated that Fraser Hill has a granite rock that 

has fined and  coursed grain. It is said that, on the fined grain granite has more cracks 

compared to the coursed grain granite. Most of the granite found in Fraser Hill is formed 

in early Mesozoic or early Tertiary. According to Roe (1951) the coarse grain granite 

formed during the early formation of  the rock. It is because the tin mineral that exists on 

the fine grain granite. Moreover, from this  study it is reliable that the granite has 

undergoes crystallization of magma during the last phase. 

 Other than that, Roe (1951) has reported from its study, the Fraser Hill area 

formed by amphibole schist. This is supported also by (Koopmans, 1974) which is it has 

actinolite schist, tremolite schist and proxene schist (Goh, 2011) also reported that schist 

amphibole can be found KM15 Jalan Kuala Kubu Bharu – Bukit Fraser it is from the 

structure roof pendant on the granite rock. 
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2.4  ELECTRICAL RESISTIVITY SURVEY 

2.4.1 INTRODUCTION 

  Geophysics is a branch of geoscience that use principles of physics to study 

about the earth. This method was expanding fast during this decade and it became one of 

the technology in earth subsurface survey. Geophysics also helps more researchers in 

order to understands about the earth tectonic theory (Samsudin, 2016). 

  Usually resistivity of rock is depends on the amount of groundwater present and 

based on the salts dissolved in the rocks. Besides that, the resistivity also decreased by 

the presence of many ore minerals and by high temperatures. 

  The main purpose of using this method are therefore for mapping the presence of 

rocks which has different porosity that particularly are connected to hydrogeology for 

detecting aquifers, contamination and for mineral prospecting. There are other uses such 

as investigate  saline and other type of pollution, archaeological surveying and detecting 

hot rocks. 

  This resistivity surveying method use to investigate the subsurface by passing 

electric current through it by means of electrodes pushed into the ground. Before this, 

these techniques have been designed to determine the vertical structure of earth which 

known as vertical electrical sounding (VES), or lateral variation as electrical profiling. 

But then, the more sophisticated method is being improve use when there are both 

vertical and lateral variations. 

  Electrical resistivity is a study of geology that use geophysics theory that may be 

contracted in the context of flow of current through a subsurface medium that consist of 
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layers of materials with different resistivity (Hermana, 2000). 

  Based on previous research found that there are several ways the current flow 

through the rock mass. There are electrolytes, electronic, dielectric conductivity 

(Reynolds, 1997). The  movement of ions in the electrolyte is the study field of the 

electrolytic conductivity. Ion concentration and mobility of ion are depending and rely 

on the type of ion. The specific charges will be control the movement of the ions. For the 

weak conductor it just exists the dielectric conductivity. In research by (Reynolds, 

1997), in every rock have their own conductivity and porosity. Later, the conductivity 

will be affected the porosity of the lithology. For rock such as graphite, pyrite, 

chalcopyrite, galena, and magnetite will have categorized and grouping as a good 

electrical conductor. 

  Induced polarization survey is a survey that measure the time for potential 

changes (voltage) decay in between two electrode that when the electric current are 

decided on top of the soil which first done by Schlumberger (1920). Soil characteristics 

that allow induced polarization  when it contain clay minerals which make it to 

expand and shrink, this characteristics of soil often cause the damage on the engineering 

structure (Peters & Fowler, 2002). 
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2.4.2 RESISTIVITY ARRANGEMENT 

 There are three types of commonly and normally used electrode array which is 

Schlumberger arrays, Wenner arrays and also Dipole-dipole arrays. 

I. Wenner Arrays 

Wenner consist of four collinear with equally spaced electrodes. The 

arrangement of the Wenner arrays the spacing will be expand about the 

array midpoint while maintaining and equal spacing between each electrode. 

This array only can survey in moderate depth of investigation (Loke, 

2018)Table 2.1 shows the advantages and disadvantage of Wenner Arrys. 

Table 2.1 Advantages and Disadvantages of Wenner Arrays 

Advantages Disadvantages 

a. Is good resolving vertical 

changes 

b. Can detect high background 

noise and can give true value of 

subsurface 

a. Poorly in detecting horizontal changes 

  (Source: Loke, 2000) 

II. Dipole-dipole Arrays 

According to Loke (2000), this survey is approximately use because of the low 

electromagnetic connection between the current and potential circuits. This arrangement 

is involving of the potential electrodes, pair of electrodes and also currents. The dipole is 
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a paired electrode set with the electrodes located closed to one another. Table 2.2 shows 

the advantage and disadvantages of dipole-dipole arrays 

Table 2.2 Advantages and Disadvantages Dipole-Dipole Arrays 

Advantages Disadvantages 

a. Good mapping for vertical structure, 

such as dykes and cavities 

a. Poor in mapping horizontal 

structure 

b. The small signal strength for 

large value of the „n‟ factor. 

 (Source: Loke, 2000) 

III. Schlumberger Arrays 

 The four collinear electrodes electrodes were used in this Sclumberger array. The 

arrangement of this array was comprise by the current electrodes and the inner two 

electrodes. The potential electrodes were positioned at the same position while for the 

current electrode are increase to a greater separation. The expanding the current 

electrodes take place roughly six times per decade. Table 2.3 shows the advantage and 

disadvantages of Schlumberger arrays 

 

 

 

 

 

FY
P 

FS
B



15 

 

Table 2.3 Advantages and Disadvantages of Schlumberger Arrays 

Advantages Disadvantages 

a. Fewer electrodes need to be moved 

b. The cable length for potential electrodes is 

shorter 

c. Greater probing depth and less time-

consuming then Wenner 

a. Long current electrode cable 

b. Recording instrument need to be 

sensitive 

c. Array may be hard to coordinate in the 

field 

 (Source: Loke, 2000) 

 

2.4.3 GEOPHYSICAL METHOD ANALYSIS 

The geophysical electrical resistivity analysis is made by the data obtained from 

the fieldwork. The data are obtained when the ABEM Terrameter LS has been 

conducted in the field. The measuring taking a long time to obtain the final results. In 

the field we have to set up the ABEM Terrameter to choose the method. In this study 

Wenner – Schlumberger array has been choosen. Then the final result will be obtain and 

process in the field. 

According to (Reynolds, 1997), the geo-electrical resistivity method is one the 

most flexible and important for the exploration of the research environment. Reynolds 

(1997) has highlighted that this method has been develop in year 1990. It has been use 

the general principle of the Ohm‟s law. By the time, this method can be used for 

detecting the properties underground and subsurface, geological structure and the 

resistivity of the subsurface of the earth in selecting of the geohazard such as landslide. 

The data that has been obtained from the ABEM Terrameter LS will be transfer to the 

flash USB. Then the data will be transfer to the software of Terrameter LS Toolbox. In 
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that software, the topography data can be put in the software. Then, the all data in this 

software can be export to DAT file. The Terrameter LS Toolbox has its own functions 

and the main reason of using the Terameter LS Toolbox is to export and convert the data 

field to be DAT file. 

After the fieldwork data has been converted to the DAT file, the data can be 

process by using the Res2DINv software. This software actually can give the better 

information that could lead the accurate interpretation of the resistivity pseudosection 

profile. 

2.5  LANDSLIDES 

2.5.1  INTRODUCTION 

Landslides are important activities of hazard that occurs around the world, it is 

connected with other hazards such as volcanic activity or earthquakes (Keller, 2019). 

The  majority of landslides are small and slow but it can be fast and catastrophic. 

Moreover, according  to (Turner & Schuster, 1996) they are categorized landslides into 

five types which is fall, topple, slide, spread, and flow. 

a. Fall – Rock or debris move rapidly and extreme in vertical movement. This type 

usually has low moisture (Gilchrist & Summerfield, 1991). 

b. Topple – a process of rotation out of a mass of soil or rock about a point or axis 

below the center or gravity of the displaced mass. 

c. Slide – movement of soil or rock through the downslope when there is a rupture 

on the surface. Slide has two types which is rotational or translational and the 

moisture is low to moderate (Gilchrist & Summerfield, 1991). 
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d. Spread – Movement of cohesive soil or rock mass over a material unstable. Due 

to the different material and water interaction the movement is complex. 

e. Flow – movement of no consolidate materials and this movement can be fast or 

slow depends of the materials and the moisture (Gilchrist & Summerfield, 1991). 

One of the reason landslides occur is the weather which is can be complex in different 

types of landslides. Extreme weather events such as high intensity rainfall or long 

periods of rain may produce landslides dangerous (Keller, 2019) 

2.5.2  OLD-DORMANT LANDSLIDE 

Normally landslides that hidden under thick and densely forested are called old-dormant 

landslides. It is in a large scale and deep-seated (Tajul Anuar, 2019). Due to increase of 

infrastructure  damage and disruptions to human activities this type of landslide has 

been increasingly recognized as a serious natural terrain geohazard. 
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CHAPTER 3 

 

MATERIALS AND METHODOLOGIES 

 

 

3.1  Introduction 

 In this chapter the materials and methods used in the study of geological 

mapping and analysis of rock type which are igneous rock, metamorphic rock or 

sedimentary rock. Seismic refraction survey in this study. The methodology is including 

the data collection, data processing, data analysis and interpretation. 

3.2  MATERIALS AND METHODS 

3.2.1  GEOLOGICAL MAPPING 

Materials 

 Computer Software 

  Computer software is used to get the geological data from previous 

  research or studies. 

 Map 

  Many types of maps such as landuse map, landslide map, stream map, 

  watershed map and other are use in this study for the interpretation part. 
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Methods 

 Preliminary Studies 

Preliminary studies are conduct by referred to varies medium like books, 

journals, and source from internet. This reference medium is needs to 

have early information about our research study. From the related 

research material it is important to use in literature review that relate to 

study. 

Other than that, base map produce using ArcGIS software is used to have 

clear perspective for the research. Base map is important key for 

preliminary studies on lithology, access to study area, rock and general 

features of the study area. 

Next, a variety type of maps is needed in this studies which need to be 

done by interpretation of map such as terrain map, aspect map, landuse 

map, stream map, and others. 

 Field Studies 

There are no fields studies in this research project, the studies will be 

based on the interpretation of map. The interpretation of map can be done 

by using computer software such as ArcGis, Envi, Terrameter Toolbox, 

Google Earth and many more. 

a) Interpretation Map Using Google Earth 

From the Google Earth interpretation we can know the landform of the 

study area and cross section of the area. The steps as follows, 

 First step 
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Open the google earth pro software on your laptop. 

 Second step 

Use search tools for searching your study area in google earth. 

 Third step 

Once you have found your study area. You need to add placemark in your 

study area based on coordinates. Add 4 placemark (A, B, C, and D) to 

complete the placemark. 

 4
th

 step 

 You can add polygon on the google earth pro software by using the tools 

“add polygon” 

 Add polygon followed the placemark you have sign earlier. 

 Then, landform can be identified using following steps. 

 5
th

 step, 

 Identify the landform that exist at your study area such as hill, high hill, 

valley,  and  others. 

 After you identified your landform, you need to digitize it in form of 

polygon. 

 Add a new polygon layer, then make a polygon around your landform. 

 After done digitize, you can change the colour of polygon as you wish. 

 Then click “Ok” 
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 After digitize all the landform, in order to transfer all the layer to ArcGis 

software you  need to save the layer in format KML. 

 Right click on the layer you want to save, and select the “save place as” 

b) Generate Map Using Arcgis Software. 

A. Landform Map 

 One of the types of geomorphology is landform. Landform is a natural or 

artificial feature of the Earth's ground surface or some other celestial object. Landforms 

together shape a given surface, and are known as topography for their arrangement in the 

landscape. Landform extracted from a simulated elevation model using some automated 

techniques, where modern satellites and stereoscopic aerial surveillance collected the 

data 

B. Landslide Susceptibility Map 

 Landslide or also known as landslip is the downward movement of a mass of 

rock, debris, earth or soil. Landslides occur when the shear strength of the materials that 

form the slope exceeds the gravitational and other types of shear stresses within a slope. 

Shear stresses can be built up by a number of processes within a slope. These include 

overgrazing the base of the slope, such as natural erosion or excavation, and loading the 

slope, such as a water inflow, a rise  in the groundwater table or the accumulation of 

debris on the surface of the slope. Then, short-term stresses such as those imposed by 

earthquakes and rainstorms can contribute to landslide activation. 
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 Landslides may also be enabled by processes that reduce the shear strength of a 

material in a slope. A map of landslide susceptibility will identify the areas that undergo 

landslides and  are measured from low to high. The map of the landslides susceptibility 

takes into account where and what causes the landslides occur. The parameter that can 

be used in landslide susceptibility assessment such as slope/relief, aspect, vegetation, 

land use, soil, drainage density, distance from river/fault/lineament/road and lithology. 

For this landslides susceptibility map only use four parameter which is slope, aspect, 

drainage density and hill relief. 

C. Fluvial System 

 Fluvial in term of geography and Earth science refer to the processes associated 

with the river and stream and the deposit and landform that created by them. When the 

stream, are associated with glacier, ice sheet or ice caps, the term change into 

glaciofluvial and fluvioglacial. 

Fluvial processes include the motion of sediment and erosion or deposition on 

the river bed. Erosion by moving water can happen in two ways. Firstly, the movement 

of water across the stream bed exerts a shear stress directly onto the bed. However, if the 

river carries significant quantities of sediment, this material can act as tools to enhance 

wear of the bed. Sediment in  rivers is transported as either bedload or suspended load. 

There is also a component carried as  dissolved material. 

 Fluvial geomorphology contains a rich tradition of river evolution conceptual 

models. Fluvial geomorphology is the study of the form and function of streams and the 

interaction between streams and their surrounding landscape. 'Fluvial' refers to the 
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running water processes, 'geo' refers to the earth and 'morphology' refers to the shape of 

the channel. Morphology of streams is dynamic and constantly changing. 

D. Watershed Map 

A watershed is an upslope area which contributes to the flow of water as concentrated 

drainage. Using the Spatial Analyst toolbox Hydrology toolset, this area can be 

delineated from a digital elevation model (DEM). 

Data Processing 

After map are produce and interpretation has be done, all the data need to be 

processed to make a Geological Map, this data processing can be done by using 

ArcMap.(Reynolds,1997) 

3.2.2  ELECTRIC RESISITIVITY IMAGING METHOD (ERI) 

In this part, a secondary data will be used which a data that get from the field 

study. The data need to be process using the software and produce a 2-D map of 

subsurface of landslide. From the subsurface map, the structure of the subsurface 

is investigate and also the type of rock is determine to relate all the 

characteristics with the potential of landslides hazard occur. 

a)  Data acquisition 

Secondary data is acquired from previous researcher which is also my co-

supervisor a  lecturer from UKM. The data that acquired is a pseudosection 

from the electric resistivity  method use. 

 At field survey line for electrical resistivity is around 100 meters length of cables 

 with 21 electrodes. All the lines survey is using Wenner-Schlumberger array. 
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 The reason of choosing 100 meters lines of survey is because the height of 

 landslide location is not more than 100 meters. From the survey, the depth of 

 subsurface data obtained around 10 -15 meters.   

 

b) Data processing 

 The research is made by data obtained from the fieldwork study. 

Res2DINv software has been use to process the data that obtain from fieldwork. 

This software will provide information that could assist with more accurate 

interpretation. The processing in ABEM Terrameter LS also require long time to 

finish. This processing will be process in the  field and then will continue after 

field work in Res2DINv software. 

 According to (Loke, 2018), to process the data from field, we have to 

 convert the data into DAT file. Then after entering the DAT file into the 

 Res2DINv, the bad data points must be removed to avoid the processing of the 

 bad data points. The resist to remove the bad data points will give an inaccurate 

 result in the final results. Before carrying the inversion, we must make sure that 

 we have edited bad data points by clicking it with the mouse of the computer. 

 Normally, the bad data points, cause of the problem of the poor ground contact 

 of electrodes while we are doing in the field. It will give a result of the higher 

 error reading in the final results.  

 After, remove the bad data points, bad data points can be checked using 

 the “ Edit File”. Then, the data points that has been edit, it will be saved as a new 

 file. The next step, the data has been saved will be proceed by inverse the data by 
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 using the “Inversion Option”. Then it will process until the error can be 

 minimized. Finally to get the true resistivity model, the “Least- Square 

 Inversion” has been clicked. Then the pseudosection profile has been produced 

 with the minimum error. 

b) Data analysis 

 The data that require in fieldwork and also in the laboratory will be 

interpret more  to get more information about lithology, structure, mineral 

composition and moreover. Besides that, with using ArcMap 10.2, we can do 

analysis about the geological mapping and also cross section. From the map that 

we done by using ArcMap 10.2, we can interpret the type of lithology by 

interpreting the shape of contour. We also can study about the geomorphology of 

that area with focusing the elevation of the topography of  the study area. 

Furthermore, in the laboratory we can interpret the shape of the mineral by using 

the microscope. From the shape and habitat of the minerals, we can interpret 

what kind of mineral in the rock in our study area. 
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CHAPTER 4 

 

 

GENERAL GEOLOGY 

 

 

 

 This chapter explains the geological process that had been undergoes in the study 

area. The research on general geology will include the study on all aspect of geology 

such as geomorphology, petrology, lithology and structure. Other than that, the study 

can be broad to the study of stratigraphy, historical geology, and also paleontology. 

Geological process also will be highlighted in this chapter such as weathering process 

and drainage system that exists in the study area.  

 In this chapter all the information was described by obtain the data from 

literature review, and interpretation using secondary data. Geological mapping activity 

cannot be carried out due to pandemic situation. From that situation activity such as 

fieldwork for collecting data, measurement and make observation at study area cannot 

be done. The only option for obtain the data is from the interpretation using secondary 

data from internet and geology agencies.  
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4.1 Accessibility  

 The study area is cover by the forest and also palm plantation or farm. From 

Google Earth images we can see in the north-east of the study area there has plantation. 

It is located at low hill area of the study area. The other part of study area is covered by 

the forest. To arrive at the study area there are two main roads that can be used. The first 

main road is from the top of Fraser Hill- Raub District and the other road is Raub 

District at the east part of the stud area. There are lots of landslides that have been 

occurred or landslides is possible to happen at the study area because the road is 

constructed at hill area. Figure 4.1 shows the study area at Fraser Hill, Pahang. 

 

Figure 4.1 Main road in study area 
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4.2 Forestry 

 The study area is rich with the vegetation such as farm or oil palm plantation and 

also forest tree. These farm plantation and palm plantation mostly owned by the local 

people that gain their income from the activity done at that area. Other than that, the 

study area is also rich with the forest tree. There are two reserved forest at that area that 

covered most of the study area. The forestry of the study is shown in Figure 4.2. 

 

Figure 4.2 Forestry at study area 
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4.3 Geomorphology 

4.3.1 Geomorphologic classification 

 There are several processes that formed a geomorphology that can be seen at 

some area such as tectonic setting, ecology, human activity, and also climate. This study 

is defining by the influence of the processes that will shape the formation of the 

geological structure and also lithology. Moreover, from the geomorphology we can 

determine the drainage system, the steepness of contour, the slope area and also 

weathering process. From that we also can determine and study the shape of landform, 

plateau, and hill. This part also will discuss about topography, drainage system, 

landform, hill slopes, watershed, contour pattern and also weathering process. 

4.3.2 Topography 

 Topography can be used in determining the position of any feature or more 

generally any points in terms of both of a horizontal coordinate system such as latitude, 

longitude and altitude. As refer to Figure 4.3, the lowest elevation in the study area is 

260m while the highest elevation is 1360m. In the study area are majority covered by the 

forest. There are also land covers by the farm and palm plantation. Since the study area 

are located at the forest and also farm and palm plantation, the accessibility only by 

using the unpaved road and the main road at study area.  

 The top elevation in the study area is located at western part of study area. The 

study area is located at mountain ridge which is located at central belt of Peninsular 

Malaysia. 
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Figure 4.3 Topography map 

4.3.3 Drainage Pattern 

 Drainage system is mean by system that related to river, lake, and stream‟s 

pattern that formed in the formation of valley, channel and others. Some of geological 

structure formed affected due to drainage pattern such as fold, fault, and joint. There are 

many types of drainage pattern such as parallel, rectangular, radial, angular and 

deranged.  

 The drainage pattern formation also can be formed due to the topography of the 

land either that area was covered by hard rock or soft rock and as well as the gradient of 

the area itself. Moreover, topography and geology of the study area also one of the 

important factor in formation of the drainage system. In geology studies recognize the 
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drainage pattern can help us to define the rock types, recharge area and potential, and 

also its general hydrologic condition. The Figure 4.4 shows the map of the drainage of 

the study area and Table 4.1 shows the characteristics of drainage pattern. 

 

Figure 4.4 Drainage pattern of study area 
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Table 4.1 Classification of drainage pattern 

 

4.3.4 Watershed 

 This part is explains about the watershed which means the place where all of 

water will flow and will be accumulate. From the map that has been produced, the 

watershed has been flowing from the hilly area to tributaries and will accumulate at the 

river. The main river that the watershed will accumulate in the study area is Sungai 

Teranum. The watershed of the study area is shown in Figure 4.5 

Rectangular Pattern Pinnate Pattern 

Drainage Pattern that have rivers with 

right-angle bends. It forms where the 

bedrock is faulted and jointed 

Pinnate Pattern develops at a narrow 

valley flanked by steep ranges. The 

tributaries originate from steep sides and 

join to valley at acute angle FY
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Figure 4.5 Watershed map  

4.3.5 Landform 

 Landform is one of the geological features that exist in the earth surfaces, it is 

part of the terrain. Some of the landforms that exists are canyon, valley, ridge, and basin. 

The landform formation usually created by tectonic plate movement under the earth. 

Other than that, erosion process that affected by agent such as water and wind also can 

create new landforms like valleys. 

 In the study area at Fraser Hill, Pahang the landform mostly covered by the high 

hill slopes geomorphology and also hill geomorphology. Some of the area is also 

covered by tributaries type. This landform has been influenced the position of the 
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research area which it lies to the central belt of the peninsular Malaysia which due to the 

tectonic plate movement. Figure 4.6 shows the landform map in the study area. 

 Most of the landscape at the study area is covered by hillslopes. Most of the 

hillslopes are steep. This condition has occured due to the natural condition such as 

water, sediments and rock move down slope under natural condition due elevation and 

gravity. The present topography and soil thickness reflect the geology process such as 

weathering, erosion, and also depositional activity.  

 

Figure 4.6 Landform map 
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4.4 Stratigraphy 

 

Figure 4.7 Geological Map of Study Area 

 Stratigraphy is the field of geology that concerned with the study of rock layers 

which is known as strata and layering. In this study it needed to interpret the history 

represented by these rock layers. Lithostratigraphy is the arrangement of rock according 

to their age which the oldest rock unit lies at the bottom and the youngest unit of rock 

lies at the top. The lithostratigraphy of study area is shown in Table 4.2 

 The formation of study area is main range granite on central belt of peninsular 

Malaysia and also Bentong-Raub Suture. The age of main range granite is around 

Mesozoic and Early Tertiary while the Bentong-Raub Suture is on the Silurian or 

Ordovician age. This statement can be proved by the previous research which is done by 
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(Hutchison, 1977) and also (Roe, 1951)reported the area of Fraser Hill formed by 

amphibole schist. 

 For the main range granite the rock unit can be found in the study area are biotite 

and amphibole granite. While for the other rock unit in the study area are interpreted as 

schist. There are several type of schist may be found in the study area such as amphibole 

schist, actinolite schist and tremolite schist.  

Table 4.2 Stratigraphy column of study area 

 

 

 

Age Lithology Description 

Mesozoic/ Early 

Tertiary 

Biotite and amphibole 

granite 

Fine grain, coarse grain. 

The granite intrudes the schist 

unit.  

Silurian/ Ordovician Amphibole schist, actinolite 

schist, tremolite schist 

Foliated minerals 

There are evidence of the 

schist has been intruded by the 

roof pendant at the top of the 

Fraser Hill. 
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4.5 Lithostratigraphy 

4.5.1 Schist unit 

 Schist is a foliated metamorphic rock. The texture of the rock usually a medium 

to coarse grained, it is also strongly foliated rock which rich in platy or elongated 

minerals. The formation of schist occurs during regional metamorphism. The parent rock 

for schist is can be either siltstone or shale, when the metamorphism caused the rock 

change due to high pressure and temperature and formed schist unit. 

 From the previous research it stated that the schists of the Foothills Range are 

predominantly quartz-mica schists with variety of politic such as quartz-graphite schist 

and subordinate lenses of amphibole schist. According to (Haile, 1977)in the Cheroh 

area which nearby the study area the schist contains biotite as well as muscovite, 

sericite, chlorite, and carboniferous matter. It is also considered that the rocks are belong 

to epidote-biotite sub facies of the greenschist facies. 

 It is said that the schists are strongly folded and also shows a micro-folding and 

crenulation that indicate the rock already folded at least twice. The intensity of folding 

and schistosity shows that obviously to their position on the flanks of the granite 

intrusion. The schist units are separated because there are overlying chert or argillite by 

a major unconformity. Between the schist and the overlying bed there are no 

discordancy in general strike even though there are difference in metamorphic grade and 

tectonism. It is said that the schist outcrop extends 37 km along a north-north westerly 

trend and both end is truncate by the granite. 
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4.5.2 Granite unit 

 Granite is a volcanic rock that intrudes the earth surface to form a batholith. It is 

phaneritic rock which shows a light colored. The primary mineral that usually exists in 

granite is quartz, feldspar, and plagioclase. Granite can be both either fine grain or 

coarse grain, it is according to the cooling process that occur on that rock itself either 

slow or fast cooling. Fine grained granite has more discontinuities compared to coarse 

grain granite. It is because there has difference in their rock materials and rock mass.  

 Based on my readings and interpretation using aerial image, most of the study 

area in Fraser Hill is covered by the granite intrusion. This feature can be seen obviously 

from the geomorphology and landform of the study area by using terrain map, landform 

map, and others. There are several types of granite that can be found in Fraser Hill such 

as biotite and amphibole granite.  

 Other than that, from my interpretation based on contour at the study area there 

are noticeable changes in contour pattern that indicate the changes in type of rock. There 

are area that has gentle slope and also steep slope. It interpreted as contour that has steep 

slope is the granite unit. It is because we can see the forms of intrusion in that area. 

 Then, based on previous research done by (Roe, 1951)reported that rock unit that 

exist at Fraser Hill are fine grain and coarse grain granite. Granite found is believed to 

be in Carbon age and its likely to form during early Mesozoic or early Tertiary. On the 

same study its reported that coarse grain granite appear during early formation and based 

on the tin mineral on the granite it is reliable that granite undergo final phase of magma 

crystallization. 
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4.6 Structural Geology 

 Structural geology is the study about the discontinuities such as deformation, 

structure, and also arrangement of the rock which affected by the movement of plate 

tectonic. The example of the geological structure is fault, fold, cleavage, vein, and joint. 

In this chapter the analysis of geological structure done by interpretation the terrain map, 

landform map, and others. From that several map we can do lineament analysis at the 

study area. Figure 4.8 Shows the lineament map of Fraser Hill, Pahang and figure 4.9 

Shows the rose diagram analysis of lineament at Fraser Hill, Pahang 

 

Figure 4.8 Lineament map 
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Figure 4.9 Rose diagram for lineament map 

 Correspond to the lineament analysis has shown that the major force is at W 330⁰ 

N which shows the most lineament is strike to WN. While, the minimum force is at N 

80⁰ E which trending to NE. From this lineament most of the structure analysis can be 

studied according this lineament. 

4.6.1 Faulting 

 Fault is a geological structure that has a fracture or zone of fractures that occured 

between two blocks of rock. Movement of block of rock is relative to each other. This 

faulting process can occur in two ways either fast or slow movement which is due to 

earthquake and creep respectively. Other than that, the length of fault may range from a 

few millimeters to thousands of kilometers. Along the geological time faults it can 

produce repeated displacement at the same place.  

 Based on the interpretation, at the study area there are major faults that can be 

seen through the aerial imagery. The faulting forms the valley at the study area 

 𝜎1 
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continuous to the river. Valley and a straight pattern of river usually can form from the 

faulting itself. Then, from the interpretation the type of faults that exist in the study area 

is strike-slip fault. That fault moves towards from south west to north east direction and 

the length of the fault line is about 1km.  

 Next, from the previous research it has been said that this Main Range is 

bounded with two major fault which is Kuala Lumpur Fault and Bukit Tinggi Fault. 

Other than that, minor fault also can be found in the range by seeing the shape of the 

granite outcrop that has foliation, mylonite and long lineation (Koopmans, 1974) 
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4.7 Historical geology 

 The formation of study area can be divided into two formation which is Main 

Range Granite and Bentong Group. The geological age for the Main Range Granite is 

Mesozoic or Early Tertiary. While the Bentong Group is at Silurian or Ordovician age 

based on the previous research. 

 For the Bentong Group, whereas the Foothills Range, mostly 600m high or less, 

are extend from Karak north-northwest through Bentong and passing at west of Raub. 

This formation is composed of various sedimentary and metasedimentary rocks which 

have same direction of trending with general steep easterly dips. Based on Richardson 

(1939) it is considered the schist and amphibole schist along the west side of the 

Foothills Range in the Raub area to be the metamorphic equivalent of the Calcareous 

Formation 

 The Main Range Granite is said to be formed during early Mesozoic or early 

Tertiary. Research done by (Roe, 1951)said during the early formation coarse grain 

granite has been forms. Crystallization of magma occurs during the last phase of the 

granite intrusion. During the intrusion of granite, the process regional metamorphism 

occurs at the area of Fraser Hill. 
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CHAPTER 5 

 

ELECTRICAL RESISTIVITY SURVEY FOR LANDSLIDE AT FRASER HILL, 

PAHANG 

 

 

 

 Occurrence of landslide usually influenced by the rock material and also rock 

mass. Rock material is the distribution of rock and mineral compositions of the rock 

bodies. Other than that, there are others factor that influence the stability of the landslide 

such as weathering. Weathering of the rock are the main reason for strength of the rock 

and stability decreasing. Weathering of the rock can be divided into six classes that have 

different explanation. Weathering is the process of deterioration of a rock mass to a soil 

and comprises the effect of both chemicals decomposition and mechanical 

disintegration. Besides that, presence of the substance such as clay and also water should 

be the major highlights as it give a factor of the influence of the landslide‟s stability. All 

of these factors can be detected by using the electrical resistivity survey which also 

known as ERI. 

 The study of electrical resistivity survey has been done in three different 

localities. Each locality has been conducted one line of electrical resistivity to obtain the 
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pseudo section of subsurface. Since it has been choosing three landslide locations so it 

will produce three lines in three landslides.  

 The survey line for electrical resistivity is around 100 meters length of cables 

with 21 electrodes. All the lines survey is using Wenner-Schlumberger array. The reason 

of choosing 100 meters lines of survey is because the height of landslide location is not 

more than 100 meters. From the survey, the depth of subsurface data obtained around 10 

-15 meters.   

5.1 Geophysical Method Analysis 

The geophysical electrical resistivity analysis is made by the data obtained from 

the fieldwork. The data are obtained when the ABEM Terrameter LS has been 

conducted in the field. The measuring taking a long time to obtain the final results. In 

the field we have to set up the ABEM Terrameter to choose the method. In this study 

Wenner – Schlumberger array has been choosen. Then the final result will be obtain and 

process in the field. 

According to (Reynolds, 1997), the geo-electrical resistivity method is one the 

most flexible and important for the exploration of the research environment. Reynolds 

(1997) has highlighted that this method has been develop in year 1990. It has been use 

the general principle of the Ohm‟s law. By the time, this method can be used for 

detecting the properties underground and subsurface, geological structure and the 

resistivity of the subsurface of the earth in selecting of the geohazard such as landslide. 

The data that has been obtained from the ABEM Terrameter LS will be transfer to the 

flash USB. Then the data will be transfer to the software of Terrameter LS Toolbox. In 
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that software, the topography data can be put in the software. Then, the all data in this 

software can be export to DAT file. The Terrameter LS Toolbox has its own functions 

and the main reason of using the Terameter LS Toolbox is to export and convert the data 

field to be DAT file. 

After the fieldwork data has been converted to the DAT file, the data can be 

process by using the Res2DINv software. This software actually can give the better 

information that could lead the accurate interpretation of the resistivity pseudosection 

profile. 

5.2 Res2DINv Software Program 

According to (Loke, 2018), to process the data from field, we have to convert the 

data into DAT file. Then after entering the DAT file into the Res2DINv, the bad data 

points must be removed to avoid the processing of the bad data points. The resist to 

remove the bad data points will give an inaccurate result in the final results. Before 

carrying the inversion, we must make sure that we have edited bad data points by 

clicking it with the mouse of the computer. Normally, the bad data points, cause of the 

problem of the poor ground contact of electrodes while we are doing in the field. It will 

give a result of the higher error reading in the final results.  

After, remove the bad data points, bad data points can be checked using the “ 

Edit File”. Then, the data points that has been edit, it will be saved as a new file. The 

next step, the data has been saved will be proceed by inverse the data by using the 

“Inversion Option”. Then it will process until the error can be minimized. Finally to get 
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the true resistivity model, the “Least- Square Inversion” has been clicked. Then the 

pseudosection profile has been produced with the minimum error. 

5.3 Data Interpretation 

 The geophysical properties of rock can be interpreted by using several chart or 

classification. In this study, classification that has been used is resistivity values for 

different lithological sections by (Srinivas, 2013).  Other than that, representative chart 

by (Palacky, 1990) also been used in this study which in most texts on applied 

geophysics. Besides that, in order to strengthen the interpretation of pseudosection 

profile there are some references that have been used to interpret the data as shown in 

Figure 5.3. 
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Figure 5.1 Resistivity value for different lithology 

(Source:(Srinivas et al., 2013)) 
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Figure 5.2 Chart of using electrical resistivity 

( Source: (Palacky et al., 1990) 
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Figure 5.3 Resistivity value use in ERI survey    

Source (Giao et al., 2008) 

Besides that, this survey also using Induced Polarization (IP) method. According 

to (Ayolabi, 2013), this method is created on the study of potential measurement 

observed in geological formations when direct current is sent into them. This mechanism 

will operate when the current is suddenly switched off, then the potential difference will 

be observed between the measuring electrodes that does not vanished instantaneously 

but gradually dies down in course of a few seconds or minute. This is the chargeability 

measure in millisecond (msec) or in mV/V. Table 5.1 shows the chargeability of the 

lithology unit. 
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Table 5.1: Chargeability of the materials 

Materials Chargeability (MS) 

Groundwater 0 

Alluvium 1-4 

Gravels 3-9 

Precambrian Volcanics 8-20 

Precambrian Gneisses 6-30 

Schists 5-20 

Sandstone 3-12 

rightArgillites 3-10 

Quarzite 5-12 

(Source: (Elijah A. Ayolabi & Oyelayo, 2005)) 

 Resistivity data is interpreting after getting the results. Table 5.2, 5.3, and 5.4 

show the geo-electrical resistivity results for each line survey. While, Figure 5.3, 5.4, 

and 5.5 shows the pseudosection profile of each survey line. 
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5.4 Discussion 

 In this research there are three locality of landslides that has been studied. The 

three locations are located at the center of Fraser Hill town. Each landslide has been 

conducted with one survey lines of electrical resistivity imaging (ERI). The data is 

obtained from this method and interpreted for the landslide possibility to occur at that 

specific area.  

 

Figure 5.4 Location map of landslide survey 

Source: (Arifin et al, 2020) 
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Figure 5.5 Landslide Hazard at Fraser Hill 

Source : (Arifin et al, 2020) 
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Geo-electrical in slope 1 

Table 5.2 Data interpretation for slope 1 in resistivity 

Description Value ( Ωm ) Distance (m) 

Topsoil clay/silt 0 - 800 27 – 40 

Topsoil gravel 

(weathered granite) 

800 – 1700 8 – 13, 14 – 16, 17 – 26 

Fresh Rock (granite) 

 

 

1700 – 3000  2 – 34  

 

 

Figure 5.6 Pseudosection for slope 1 (Jeriau)  
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The data is obtained from this survey line is shown in Figure 5.4. From the 

pseudosection profile the survey line is 50 meter in length and the electrode spacing 

used in this survey is 1 meter. This survey is using Wenner-Schlumberger array and the 

depth of subsurface that we can get from this method is 8 meter. 

 From the Figure 5.6, this area has a high value of resistivity. The high value of 

resistivity is estimate to be hard rock. From the geological studies at this place the hard 

rock that exist in this area is igneous rock which is granite. In the pseudosection profile 

of this area was represented by green to purple color. The range of resistivity value is 

1000 Ωm to 3000 Ωm. This type of rock can be seen dominated at the bottom layer of 

the pseudosection profile.  

 Next, from the pseudosection profile of the area that has intermediate value of 

resistivity is shown in turquoise to green color. The resistivity value for this part is 

ranged from the 800 Ωm to 1500 Ωm and is known as fractured zone that consists of 

weathered granite. This fractured zone mostly can be seen at the center of pseudosection 

profile which is between 15 m to 17m and from 18m to 24m. Then, the lowest resistivity 

value that is obtained from the pseudosection profile is in range from 0 Ωm to 800 Ωm. 

This resistivity value indicates the topsoil of the slope which is clay or silt.  

 This area was represented as the location that has a weak zone. The appearance 

of water saturated is the reason why the landslide is occured. In addition, the sliding 

plane of the landslide was along the line. The pseudosection has shown that the sliding 

plane was dominated by the weathered rock. The distance of sliding plane is ranged 
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between 16 m to 40 m that shown it has the deposit by the water saturated zone. This 

zone trendily makes the weathered granite to move at the downward area. 

 Other than that, lithology of the fractured zone of granite can be one of the 

reasons for landslides to occur. This is because at that area there are weathering process 

that occured such as chemical and biological weathering. The rock material may react 

with water from the rain or may weathered because of the vegetation that existed at that 

area. Because of that, with the season rain at this area can affect the weakness of the 

subsoil and affected the fractured zone. So, the slightest movement or extreme weather 

will cause a landslide. 
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Geo-electrical in slope 2 

Table 5.3 Data interpretation for slope 2 in resistivity 

Description Value ( Ωm ) Distance (m) 

Topsoil clay/silt 0 - 800 35 – 43 

Topsoil gravel (weathered 

granite) 

800 – 1700 3 – 30 

Fresh Rock (granite) 1700 – 3000  7 – 10 , 10 – 17,  20 – 37 

 

 

Figure 5.7 Pseudosection for slope 2 ( Tasik ) 
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 The data is obtained from this line of research is shown in Figure 5.7. The survey 

line is 50 meters in length from the pseudo-section profile and the electrode spacing 

used in this analysis is 1 meter. This research uses the Wenner-Schlumberger array and 

the subsurface depth is 8 meters. 

 From the Figure 5.7, this area has a high value of resistivity. The high resistivity 

value is calculated to be hard rock. The hard rock that occurs in this region is igneous 

rock and interpreted as granite from geological studies at this site. This region was 

represented in the brown to purple color shown in pseudosection profile. The resistivity 

value ranged is 1500 Ωm to 3000 Ωm. In the bottom layer of the pseudo section, this 

type of rock can be seen dominating. 

 Next the region that has an intermediate value of resistivity is shown in green to 

yellow color from the pseudo segment. For this section, the resistivity value is ranged 

from 800 Ωm to 1500 Ωm, and this portion is known as the weathered granite fracture 

zone. At the middle of the pseudosection, which is between 10 m to 12 m and 20 m to 24 

m, this fractured zone is most evident. Then the lowest resistivity value that can be 

derived from the pseudo-section varies from 0 to 800 m. This resistivity value is 

interpreted as the slope's topsoil, which is clay or silt. 

 This region has been described as a weak zone. The appearance of saturated 

water is the explanation for the landslide occurring. Additionally, along the axis was the 

slipping plane of the landslide. The pseudo-section showed that the weathered rock is 

dominated the sliding plane. The width of the sliding plane between 34 m to 50 m has 
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been shown by the water saturated zone to have the deposit. The weathered granite is 

typically shifted to the downward zone. 

 Other than that, one of the factors for landslides to occur is the lithology of the 

granite fracture zone. This is occurred because of the weathering processes, such as 

chemical and biological weathering. The material of the rock may respond to rain water 

or may be weathered because of the vegetation that existed in that region. Therefore, 

with the rainy season at this area can affect the subsoil and the fracture zone. So the 

slightest movement or extreme weather will cause a landslide.  
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Geo-electrical in slope 3 

Table 5.4 Data interpretation for slope 3 in resistivity 

Description Value ( Ωm ) Distance (m) 

Groundwater 0 – 100 4 – 34 

Topsoil (Clay/ Silt, Gravel) 100 - 1000 0 – 40 

 

 

Figure 5.8 Pseudosection for slope 3 (Masjid) 
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 Figure 5.8 indicates the data collected from this line survey. The length of the 

survey line from the pseudo-section is 50 meters and the electrode separation used in 

this study is 1 meter. This study utilizes the technique of Wenner-Schlumberger array 

and the depth of the subsurface is 7 meters. 

 In the pseudosection profile, this area was dominated with blue color at the 

bottom layer and at the upper represented is light blue to purple color. The blue color 

represents low resistivity value while range from light blue to purple color is high 

resistivity value. In this pseudosection, there is two lithologies that were interpreted to 

be groundwater and topsoil that consist of clay, silt and gravel. 

 The range of the resistivity value for groundwater is ranged from 0 Ωm until 100 

Ωm. This position was located at depth 0.5 m to 6.25 m at distance from 4 m to 34 m. 

Besides that, another range of resistivity value is from 100 Ωm to 900 Ωm. This 

resistivity value can be observed at depth 0 m to 2.70 m and at distance 1.25 m until 38.5 

m.  

 This area is dominated with fractured zone and topsoil area. This appearance of 

fracture zone and water saturated zone are the reason for the landslides to occur. Plus, 

landslides can occur in any area that contains fractured materials near the top of a steep 

slope. Also, with the rainy season at this area can affect it weakness of the sub soil 

making it weaker. So the slightest movement or extreme weather will cause a landslide. 

 In addition the sliding plane of the landslide was along the line. The 

pseudosection profile has shown that the sliding plane was dominated by the weathered 

rock. The distance from 0m until 100m has shown it has the deposit by the water 
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saturated zone. This zone tenderly makes the weathered andesite to move at the 

downward area. The weakens of the cohesion force of the rock make it easier to move 

downward along the sliding plane.  

 In a conclusion, all three location has the potential for landslide to occur based 

on the material that exist at sliding plane of the slope. Most of the rock material that 

exist at the slope are in form of topsoil and has high water content. This can be one of 

the factor for landslide to occur.   
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CHAPTER 6 

 

CONCLUSION AND RECOMMENDATION 

 

 

6.1 Conclusion 

 Based on the geological studies, the study area is located at Central Belt of 

Peninsular Malaysia. The study area consists of two formation which is Main Range 

Granite and Bentong Group. The lithology exist in study area is granite and schist with 

different type of minerals. Other than that, the geomorphology classification at this study 

area can be divided into three classes. The first class of geomorphology is class 3 which 

the elevation ranging from 200 meter to 500 meter. Then, at elevation 500 – 1000 meter 

the geomorphology was classified with value of 4. Lastly, the value of class is 5 which 

include the elevation more than 1000 meter. In the study area there are also has many 

geohazard such as landslide. Next, through the study of drainage map, the drainage 

pattern is rectangular and pinnate pattern. 

 The formation of study area can be classified into two formation or groups which 

is Main Range Granite and also Bentong Group. The geological age for Main Range 

Granite is ranging from Mesozoic to Early Tertiary while for the Bentong Group the 
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geological age is ranging from Silurian to Ordovician. This statement proved by many 

previous research such as (Hutchison, 1977) (Sulaiman & Rosli, 2010). 

 Next, for the Bentong Group the geological age is ranging from Silurian to 

Ordovician. The rock unit that has in the study area specifically is schist, but there are 

another type of schist that exists such as amphibole schist, actinolite schist, and tremolite 

schist. This rock unit is much oldest than the Main Range Granite. The Main Range 

Granite intrude the area of schist that cause regional metamorphism. All this information 

supported by previous research done by (Haile et al., 1977). 

 Electrical resistivity imaging is the most used method for landslide and 

groundwater monitoring investigation. This method used because by obtain and analysis 

the data we can know the resistivity value and the lithology of the subsurface at the 

study area. For this research, electrical resistivity imaging methods were done at three 

locations with three lines survey. This survey is important to know the potential for 

landslide to occur. 

 In slope 1, the rock unit that dominated in the pseudosection is granite which 

most of the rock lies at the bottom layer. Other than that, fracture zone that consists of 

weathered granite also exists at the slope. This fracture zone can be the main reason for 

landslide to occur at that specific slope. At this area of slope there are also have high 

vegetation which can be the reason for biological weathering. Then, because of this two 

parameters process of the weathering might be happening in the beneath of the 

subsurface. Also, with the season rain at this area can affect it weakens the sub soil 

making it weak.   
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 In slope 2, the rock unit that exists in the pseudosection is granite which most of 

the rock lies at the bottom layer. Other than that, fracture zone that consists of weathered 

granite also exists at the slope and this lithology is dominate most of the pseudosection. 

Most of the fracture zone is located at the top of the slope that can be the main reason for 

the residue to move downwards the slope. This fracture zone can be the main reason for 

landslide to occur at that specific slope. There are also lithology of topsoil that consists 

of clay or silt at this slope. At this area of slope there are also have high vegetation 

which can be the reason for biological weathering. Then, because of this two parameters 

process of the weathering might be happening in the beneath of the subsurface. Also, 

with the season rain at this area can affect it weakens the sub soil making it weak.   

 In slope 3, from the pseudosection can be observed that most of the subsurface 

area is dominate by groundwater, clay, and silt at the bottom layer. Then at the upper 

layer gravel can be observed through the pseudosection. It can be said that this slope is 

consists of loose material that can be the reason for landslide to occur. Other than that, 

weathering can be said as one of the reason for landslide to occur. The presence of 

groundwater may be because of the existence of lake nearby the slope. Also, with the 

season rain at this area can affect it weakens the sub soil making it weak.   
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6.2 Recommendation 

 In geological part for this research mapping has been done through aerial 

imaging method and studies from previous research. This method cannot give the actual 

views of the study area. Then, the data that we obtain from the previous research is not 

up to date. Most of the data used in this research are from five years ago and below. To 

get the actual views and to update the data obtain for the geological part, geological 

mapping should be done at this study area. From the geological mapping, there are more 

specific data can be obtain such as rock unit, weathering, geomorphology, and other 

parts in geology studies.  

Then, the fieldwork is conducted by using geo-electrical resistivity, but there are 

other methods that can give accurate result such as borehole technique and also seismic 

refraction method. For seismic method, it can give high degree of precision data display. 

This method also allows mapping the thickness of the landslide and identification of 

rock. The borehole technique should also be applied at the study area to get the exact 

data in underground. With the combination of boreholes data and geophysical survey, 

the investigation of landslide can be done more effectively. 
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APPENDIX 

 

A) Steps to generate map using ArcGis 

A. Landform Map 

1. Add data from folder in the computer, choose DEM data and click to insert to the 

layers. 

 

Figure Data Elevation Model of Study Area 

2. Add basemap features like study area, river and street. 

3. Go to arctoolbox select spatial analyst tool and choose contour. 
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Figure Arctoolbox in ArcGis 

4. Then , add DEM data to convert to contour with 20m interval. 

 

Figure Steps to Convert DEM to Contour 

5. Then, go to processing then choose clip. Clip the contour and box. 
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Figure Steps to Clip the layer 

6. Then go to spatial analyst tool and search topo to raster. Then add data contour. 

 

Figure Steps to Convert from Contour to Raster 

7.Then go to properties and classified it as 3. 
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Figure Layer Properties of Raster 

B. Landslide Susceptibility Map 

1.  Slope map 

 The layer is right clicked to select properties, in order to select coordinate 

system for the map.  Geographic Coordinate System is choosing, 

followed by World > WGS 1984. 

 Add data from folder in the computer, choose DEM data and click to 

insert to the layers. 

 Add box data and do the clip feature from geoprocessing at DEM data 

into the box area  only. 

 Navigate to System Toolboxes, choose Spatial Analyst Tools > Surface > 

Slope. 

 Select the input surface raster and insert the clip DEM layer. 

 Specify the location of the output raster and select the output 

measurement. 
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 Click OK. The slope map is created from the DEM layer 

2.  Drainage density 

 The layer is right clicked to select properties, in order to select coordinate 

system for the map.  Geographic Coordinate System is choosing, 

followed by World > WGS 1984. 

 Add data from folder in the computer, choose DEM data and click to 

insert to the layers. 

 Add box data and do the clip feature from geoprocessing at DEM data 

into the box area only. 

 Navigate to System Toolboxes, choose Spatial Analyst Tools > 

Hydrology > Fill. 

 Select the input surface raster and insert the clip DEM layer. 

 Navigate to System Toolboxes, choose Spatial Analyst Tools > 

Hydrology > Flow direction. 

 Select the input surface raster and insert the clip Fill dem layer. 

 Navigate to System Toolboxes, choose Spatial Analyst Tools > 

Hydrology > Flow accumulation. 

 Select the input surface raster and insert the clip Flow direction dem 

layer. 

 Navigate to System Toolboxes, choose Spatial Analyst Tools > 

Hydrology > Stream order. 

 Select the input stream raster and insert the clip stream order dem layer, 

then insert flow direction dem layers into input flow direction raster. 
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 Navigate to System Toolboxes, choose Spatial Analyst Tools > 

Hydrology > Stream to feature. 

 Select the input stream raster and insert the clip stream order dem layer, 

then insert stream order dem layers into input flow direction raster. 

 At layers, click the stream order dem layers properties and change the 

line colour and each size. 

 Navigate to System Toolboxes, choose Spatial Analyst Tools > Density > 

Line density. 

 Select the input polyline raster and insert the clip stream order dem layer, 

then for population field choose grid code. 

 Click OK. The density map is created from the stream order layer. 

3.  Aspect map 

 The layer is right clicked to select properties, in order to select coordinate 

system for the map.  Geographic Coordinate System is choosing, 

followed by World > WGS 1984. 

 Add data from folder in the computer, choose DEM data and click to 

insert to the layers. 

 Add box data and do the clip feature from geoprocessing at DEM data 

into the box area only. 

 Navigate to System Toolboxes, choose Spatial Analyst Tools > Surface > 

Aspect. 

 Select the input surface raster and insert the clip DEM layer. 
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 Specify the location of the output raster and select the output 

measurement. 

 Click OK. The aspect map is created from the DEM layer. 

4.  Hill relief map 

 The layer is right clicked to select properties, in order to select coordinate 

system for the map.  Geographic Coordinate System is choosing, 

followed by World > WGS 1984. 

 Add data from folder in the computer, choose DEM data and click to 

insert to the layers. 

 Add box data and do the clip feature from geoprocessing at DEM data 

into the box area only. 

 Click the Image Analysis Options button Options, click the Hillshade tab, 

then adjust the illumination properties to be applied. 

 Click the Shaded Relief button Shaded Relief in the Processing section of 

the window. 

 To change the color ramp, click the newly added layer in the Image 

Analysis window, then click  the color ramp drop-down arrow in the 

Processing section and select a different color ramp. 

 Right-click the raster layer in the table of contents and click Properties. 

 Click the Functions tab. 

 Right-click Shaded Relief Function and click Properties. 

 Click the Shaded Relief tab and edit the properties. 
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 Click OK to close the Raster Properties Function dialog box and click 

OK again to close the  Layer Properties dialog box. 

5.  Landslide susceptibility map 

 The layer is right clicked to select properties, in order to select coordinate 

system for the map. Geographic Coordinate System is choosing, followed 

by World > WGS 1984. 

 Add data from folder in the computer, choose DEM data and click to 

insert to the layers. 

 Add box data and do the clip feature from geoprocessing at DEM data 

into the box area only. 

 Add the aspect, slope, drainage density and hillshade layers into map. 

 Navigate to System Toolboxes, choose Spatial Analyst Tools > Reclass > 

Reclassify. 

 Do the reclassify at the aspect, slope, drainage density and hillshade 

layers. 

 Then, navigate to System Toolboxes, choose Spatial Analyst Tools > 

Overlay > Put all the reclass layer. 

 Click OK. The landslide suscepbility map is created from the all reclass 

layer. 
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C. Fluvial System 

1. Stream Order Map 

 • The first stage of any hydrology processing is to fill any pit in the DEM 

using a filling tool to ensure that water will flow over the surface without 

being 'stuck' in the DEM's erroneous void. 

 

Figure Steps to Insert Raster Data 

 Input surface raster > DEM data 

 Then click OK. 
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Figure DEM data of Study Area 

 Once this filled DEM has been created, the flow direction can be 

calculated using the elevation to determine which direction water flows 

in each cell using the D8 method where all water flows into one of the 

eight surrounding cells. 

 

Figure Input Flow Direction 
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 Input surface raster > DEM Fill 

 Then Click OK 

 

Figure  DEM Fill  

 The flow direction can then be used to create the flow accumulation, a 

measure of the number of cells which flow into each cell in the raster. 

 

Figure Input Flow Accumulation 
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 Input flow direction raster > FlowDir 

 Output Data Type change to INTEGER 

 Then click OK 

 

Figure Flow Direction Raster 

 Then using raster calculator 
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Figure Raster Calculator in ArcToolbox 

 FlowAcc raster >= 100 

 Then click OK 

 

Figure  Flow Accumulation Raster 

 This is example of stream after raster calculate process. 
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 Use stream order tool. 

 

Figure Input Stream Order 

 Input Stream raster > raster calculate layer 

 Input flow direction raster > FlowDIr raster 

 Use Strahler method for the stream order 

 Then Click OK. 
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Figure Stream Order of Study Area 

 Stream order raster need to be converted as the final step, it need to be 

convert into a vector which is simply that shows the stream to feature 

command 

 

Figure Input Stream to Feature 

 Input stream raster > stream order layer 
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 Input flow direction > FlowDir raster 

 Then click OK 

 Complete the step. 

For other maps use in fluvial system is also the same as in landslide susceptibility map 

such as aspect map, slope map, drainage density. 

D. Watershed Map 

 Fill tool is run in the Arccatalog. 

 In ArcCatalog, Toolboxes > System Toolboxes > Spatial Analyst Tools > 

Hydrology > Fill this step used to navigate 

 Digital elevation model (DEM) is used as the „Input surface raster‟ 

 Then, at the „Output surface raster‟ the path name need to be verify 

 If necessary, put the Z-limit. 

 Button OK needed to be clicked. 

 Flow Direction tool is run 

 In ArcCatalog, use this navigation to get the Flow Direction, Toolboxes > 

System Toolboxes > Spatial Analyst Tools > Hydrology > Flow Direction. 

 DEM is used as the output in the „Input surface raster‟. 

 The path name for „ Output flow direction raster‟ need to be verify. 

 Click OK. 

 The Flow Direction tool specifies the flow direction from each cell to its 

steepest downhill neighbour. 

 Flow accumulation tool is run. 
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 In ArcCatalog, this steps is used to navigate the flow direction, Toolboxes 

> System Toolboxes > Spatial Analyst Tools > Hydrology > Flow 

Accumulation. 

 Then, output raster at step 2 is used as the „input flow direction raster‟. 

 Path name for the „output accumulation raster‟ needed to be verify. 

 Click OK. 

  The Flow Accumulation method measures each cell 's cumulative flow as 

determined by the aggregate weight of all cells flowing into each 

downslope cell. 

 Run the Snap Pour Point tool to locate high accumulated flow cells at the 

pour points. 

 Navigate to Toolboxes in ArcCatalog > Device Toolboxes > Spatial 

Analyst Software Hydrology > Snap For Points. 

 • Either input a point class feature or a raster as the 'Input raster or the 

pour point data feature.' 

 Output raster from Step 3 is used as the 'Input accumulation raster'. 

 Path name for the 'Output raster' needed to be verify 

 Click OK. 

 Watershed tool is run in the software. 

 In ArcCatalog, Toolboxes > System Toolboxes > Spatial Analyst Tools > 

Hydrology > Watershed are navigated to get the output 

 Output raster from Step 2 is used as the 'Input flow direction raster'. 

 Output from Step 4 is used  as the 'Input raster or feature pour point data'. 
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 Path name for the 'Output raster' need to be verified. 

 Click OK. 

 Then, 'Raster to Polygon' tool is used to create polygon features from the 

watershed raster. 

 In ArcCatalog, to navigate the polygon this step is used Toolboxes > 

System Toolboxes > Conversion Tools > From Raster > Raster to 

Polygon. 

 Output from Step 5 is used as the 'Input raster'. 

 Path name for the 'Output polygon features' need to verify. 

 Click OK. 
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